
SS LL OO VV EE NN SS KK ÁÁ   TT EE CC HH NN II CC KK ÁÁ   UU NN II VV EE RR ZZ II TT AA   VV   BB RR AA TT II SS LL AA VV EE   
FF AA KK UU LL TT AA   II NN FF OO RR MM AA TT II KK YY   AA   II NN FF OO RR MM AAČČNN ÝÝ CC HH   TT EE CC HH NN OO LL ÓÓ GG II ÍÍ   
Ilkovičova 3, 842 16 Bratislava 4 
 

 

 
IINNFFOORRMMAAČČNNÝÝ  SSYYSSTTÉÉMM  PPRREE  KKOOMMUUNNIIKKÁÁCCIIUU  SS  AABBSSOOLLVVEENNTTMMII  

  
  
  
  

AADDMMIINNIISSTTRRÁÁTTOORRSSKKÁÁ  PPRRÍÍRRUUČČKKAA  
 
 
 
 
 
 
 
 
 
 

BBcc..  MMiicchhaall  BBuubbaannsskkýý  
BBcc..  JJoozzeeff  ĎĎuurriišš  
IInngg..  JJoozzeeff  PPaažžiinn  

BBcc..  MMiicchhaall  SSaammiieecc  
BBcc..  MMaarrttiinn  SSttaannččeekk  

BBcc..  MMaarriiáánn  VVaašššš  

TTíímm  ččíísslloo  1188  <<ttiissvvtt1188@@ggmmaaiill..ccoomm>>    

OOddbboorr::  IInnffoorrmmaaččnnéé  ssyyssttéémmyy    

DDááttuumm::  1155..  55..  22000077  

 



IINNFFOORRMMAAČČNNÝÝ  SSYYSSTTÉÉMM  PPRREE  KKOOMMUUNNIIKKÁÁCCIIUU  SS  AABBSSOOLLVVEENNTTMMII  
 

  AADD MM II NN II SS TTRR ÁÁ TTOO RR SS KK ÁÁ   PP RR ÍÍ RR UUČČKK AA   KK   SS YY SS TT ÉÉ MM UU   AALLUU MMNNII   SS TTRR AA NN AA   11     

11..   ÚÚVV OO DD   

Táto používateľská príručka je určená pre administrátora informačného systému na 
komunikáciu s absolventmi – ALUMNI, pred jej použitím je potrebné oboznámiť sa s prácou 
v systéme pomocou používateľskej príručky. 

22..   IINN ŠŠ TT AA LL ÁÁ CC II AA   

22..11..   DDaattaabbáázzoovvýý  ss yyss ttéé mm  PPooss ttggrreeSSQQLL    
Aplikácia pracuje s dynamickými údajmi, ktoré sú uložené v databáze - PostgreSQL. Pre 
použitie s naším systémom sa odporúča použiť verziu 8.1 alebo vyššiu. Aktuálnu verziu je 
možné stiahnuť na http://www.postgresql.org/download/. Po stiahnutí systém nainštalujeme 
spolu s používateľským rozhraním pgAdmin (potrebné kroky sú popísané v príslušnej 
dokumentácii - dostupnej taktiež na http://www.postgresql.org/docs/) a podľa nasledujúcich 
krokov vytvoríme a naplníme databázu.  

22..11 .. 11 ..   VVyyttvv oorr ee nniiee   ddaattaa bbáá zzyy   aa   jjeejj   nnaa ppll nnee nniiee   
1. Vytvoríme nového používateľa – v aplikácii pgAdmin označíme aktuálny 

databázový server z ponuky Edit vyberieme New Object -> New Login Role. Do 
kolóniek Role name a Password zadáme „znalosti“ (bez úvodzoviek). Nakoniec 
potvrdíme výber stlačením tlačidla OK.  

2. Vytvoríme prázdnu databázu – v aplikácii pgAdmin označíme priečinok Databases 
a z ponuky Edit vyberieme New Object -> New Database. Do kolónky Name vložíme 
„znalosti“ (bez úvodzoviek). Z ponuky Owner vyberieme „znalosti“ a z ponuky 
Encoding vyberieme UTF8. Nakoniec potvrdíme výber stlačením tlačidla OK.  

3. Naimportujeme štruktúru databázy a údaje – označíme priečinok našej databázy 
(znalosti), z ponuky Tools vyberieme Query Tool, čím sa nám otvorí okno pre dopyty. 
Pomocou File -> Open načítame súbor znalosti.sql a z ponuky Query vyberieme 
položku Execute, čím sa nám vykoná spustenie skriptu na importovanie databázy. V 
prípade výskytu nasledovnej chyby: ERROR: language "plpgsql" already exists je 
potrebné odstrániť, alebo okomentovať (vložením dvoch znakov mínus pred reťazec) 
riadok CREATE PROCEDURAL LANGUAGE plpgsql;. 

22..22..   PPooss ttuupp  pprr ii   iinnšš ttaa lláácc ii ii   ddaattaabbáázzoovvééhhoo  ss yyss ttéémmuu  

22..22 .. 11 ..   VVýý bbeerr   jjaa zzyy kkaa  
Vyberte jazyk, ktorý chcete použiť. Je to iba nastaveni jazyka, ktorý bude použitý při 
inštalácii. Samotné PostgreSQL môže byť nainštalované s jazykovou podporou, alebo bez nej, 
táto jazyková voľba je však nezávislá od inštalátora. Môžete tiž vybrať možnosť aby 
inštalátor vytvořil podrobný záznam o instalačnom procese. Nezabudnite však, že v tomto 
súbore budú uložené heslá, ktoré počas inštalácie vytvoríte. 

http://www.postgresql.org/download/
http://www.postgresql.org/docs/)
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Obr. 1.: Výber jazyka pri inštalácii PostgreSQL 

 

22..22 .. 22 ..   UUvvíí ttaacc iiaa   ss pprr áávvaa  aa   ii nnšš ttrr uukkcciiee   
Podrobne si prečítajte inštrukcie před ďalším pokračovaním. 

 
Obr. 2.: Základné informácie o PostgreSQL 
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22..22 .. 33 ..   VVýý bbeerr   ffuunnkkccii íí   
Vyberte inštalačné súčasti, ktoré chcete používať. Pre systém ALUMNI sú postačujúce 
štandardné účasti, takže v tejto časti nemusíte nič nastavovať. Pre pokračovanie kliknite na 
tlačilo Next. 

 
Obr. 3.: Definovanie funkcií aktivovaných inštaláciou PostgreSQL 

 

22..22 .. 44 ..   II nnššttaall áácc iiaa   ss ll uužžbbyy   
Vyberte či chcete použiť PostgreSQL jako službu a špecifikujte konto pre túto službu. 

 
Obr. 4.: Inštalácia služby PostgreSQL 
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22..22 .. 55 ..   II nniicc iiaa ll ii zzáácc iiaa   ddaatt aa bbáá zzyy   
Nastavte meno a heslo pre hlavného používateľa databázy. 

 
Obr. 5.: Inicializácia databázy PostgreSQL 

 

22..22 .. 66 ..   PPrr ooccee dduurrááll nnee   jjaa zzyy kkyy  
Pre úplnú funkcionalitu postačuje voľba procedurálneho jazyka PL/pgsql. 

 
Obr. 6.: Povolenie procedurálneho jazyka PL/pgsql 
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22..22 .. 77 ..   ĎĎaall šš iiee   mmoodduull yy   
Toto nastaveni umožňuje pridanie ďalších funkčních modulov do databázy. Systém ALUMNI 
však žiadny z nich nepoužíva, takže pokračujte v inštalácii bez zmeny. 

 

 
Obr. 7.: Výber ďalších modulov PostgreSQL 

 

22..22 .. 88 ..   PPoosstt GGII SS  
Ďalšie nastavenie umožňuje vytvorenie šablóny na databázové aplikácie, ponechejte 
nezmenené. 

 
Obr. 8.: Nastavenie PostGIS 
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22..22 .. 99 ..   PPrrii pprraa vvee nnýý  nnaa  ii nnšštt aalláácc ii uu  
Kliknite na tlačilo Next, čím zahájite samotnú inštaláciu. 

 
Obr. 9.: Zahájenie inštalácie PostgreSQL 

22..22 .. 1100 ..   UU kkoonnččee nniiee   ii nnššttaall áácc iiee   
Inštalácia je kompletná. Pokračujeme nastavením databázy pre systém ALUMNI. 
 

22..33..   IInnšš ttaa lláácc iiaa   ddáá tt   

22..33 .. 11 ..   II nnššttaall aaččnnýý  ss kkrr ii pptt   
Spustite program pgAdmin (Štart – Programy - PostgreSQL 8.2 - pgAdmin III). Pripojte sa na 
databázový server podľa nasledujúceho obrázku. 
V prvom kroku sa vyberie server, ku ktorému sa pripájame (1) a v nasledujúcom kroku sa 
k databáze pripojíme (2). Tieto kroky sú znázornené na obrázku  10. Na obrázku 11 je v kroku 
(1) znázornené vytvorenie novej databázy. 
Obrázok 12 znázorňuje dáta, ktoré je potrebné vyplniť pri vytváraní novej databázy. 
Naplnenie databázy záznamami zo skriptu je popísané na obrázku 13. V kroku (1) vyberiete 
databázu alumni, ďalej spustíte editor na spúšťanie skriptov (2), tým sa otvorí nové okno (3). 
V okne editácie otvoríte pomocou (4) skript s názvom alumni20070511.sql, ako je 
znázornené na obrázku 14. Ďalej pokračujeme posledným krokom na obrázku 13 (5), keď 
spustíme samotný skript. 
Na obrázku 15 je zobrazený výsledok činnosti skriptu v prípade úspešného ukončenia. 
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Obr. 10.: Pripojenie k databáze 

 
Obr. 11.: Vytvorenie novej databázy 
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Obr. 12.: Vytvorenie novej databázy 

 
Obr. 13.: Naplnenie databázy záznamami 
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Obr. 14.: Otvorenie skriptu na naplnenie databázy 

 
Obr. 15.: Úspešné ukončenie skriptu na inštaláciu databázy 

 
Týmto krokom ste úspešne naplnili databázu pre systém ALUMNI.  
Ešte zostáva pridať privilégia pre používateľa. Môžeme to spraviť skriptom v jazyku PL/sql 
pomocou: 

GRANT ALL ON SCHEMA alumni TO admin; 
ako je to znázornené v krokoch na obrázku 16, alebo pomocou vlastností celej schémy 
alumni, ktorú nastavíte podľa obrázku 17. 
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Obr. 16.: Priradenie privilégií pre používateľa pomocou skriptu 

 
Obr. 17.: Priradenie privilégií pre používateľa pomocou nastavenia vlastností schémy 
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22..33 .. 22 ..   AA kktt uuaa ll ii zzáácc iiaa   zzoobbrr aa zzee nniiaa   ddáátt   

 
Obr. 18.: Obnovenie zobrazenia dát po zmenách 

Ak by sa Vám po ľubovoľnom kroku počas inštalácie zdalo, že sa príkaz nevykonal, použite 
„Refresh“ na ľubovoľnej vyššej úrovni. 

22..44..   PPoott rreebbnnýý  hhaa rrddvvéé rr   
Na prevádzkovanie systému ALUMNI nie sú z pohľadu hardvéru kladené špeciálne 
požiadavky. Podmienkou je možnosť nainštalovania Internet Information Server-u, z čoho 
vyplýva podmienka, že na stroj na ktorom bude je systém prevádzkovaný sa musí dať 
nainštalovať Microsoft Windows Server 2000 v krajnom prípade Microsoft Windows XP. 
Pre inštaláciu OS 512MB RAM a pre beh .NET Machine, aspoň 128MB operačnej pamäte 
pre beh samotnej aplikácie. Odporúčané min. 1024MB RAM. Je potrebné mať aspoň 10GB 
voľného miesta na pevnom disku pretože databáza má tendenciu rozrasť sa. 
Rovnaké obmedzenia ako na operačný systém sa vzťahujú aj na architektúru počítača 
samotného. Je možné použiť počítače typu: x86, x86_64. 

33..   MM EE NN UU   

Spoločné časti nachádzajúce sa na každej obrazovke (s výnimkou špeciálnych obrazoviek 
správ systému) sú tieto: 

1. Logo projektu - súčasť dizajnu. 
2. Horné menu - slúži na výber a prístup k základným častiam systému, pri prechodoch 

medzi jednotlivými časťami systému sa nebude prispôsobovať aktuálnemu obsahu 
stránky. 

3. Ľavé menu - slúži na prácu s aktívnym modulom systému, pre ktorý zobrazuje 
podrobnejšiu ponuku možností práce s danou časťou systému. Pred prihlásením 
používateľa zobrazuje formulár na prihlásenie. 

4. Hlavná časť - v tejto časti sa zobrazuje obsah jednotlivých modulov systému a slúži na 
zobrazenie výstupov a zadávanie vstupov. 

Bližšie sú uvedené jednotlivé časti systému, teda aj popis menu, ktoré sa dotýka aktuálnej 
časti. 
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44..   ČČAA SS TT II   SS YY SS TT ÉÉ MMUU   

Táto kapitola popisuje hlavné časti systému reprezentované používateľským rozhraním - teda 
navrhnutými obrazovkami systému s krátkym popisom špecifických položiek v menu. 
 

44..11..   ÚÚvvooddnnáá   ss tt rráánnkkaa   

 
Obr. 19.: Úvodná stránka projektu 

 
Hlavné časti stránky sú tieto: 

1. logo projektu – súčasť dizajnu 
2. hlavné menu – zobrazené vždy pri práci používateľa s IS 
3. prihlasovacia časť – zobrazuje meno prihláseného používateľa, alebo dovoľuje zadať 

prihlasovacie údaje 
4. novinky – zobrazuje maximálne 5 aktuálnych oznamov z nástenky 
5. úvodný text – privítanie na stránke 
6. aktuálny stav databázy – zobrazuje aktuálne informácie o počte absolventov 

a projektov evidovaných v IS 
V závislosti od prihlásenia sa mení hodnota polí 3 a 4. Po prihlásení administrátora systému 
vyzerá prihlasovacia časť tak, ako je na nasledujúcom obrázku. 
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Obr. 20.: Znázornenie prihláseného administrátora 

Prihlásení používatelia si môžu zvoliť v prihlasovacej časti (1) odhlásenie, prípadne ak ide 
o administrátora aj vstup do administračnej časti IS. 

44..22..   AAddmmiinniiss tt rráá ttoorrss kkáá   ččaassťť   
Administrátorská časť systému pre komunikáciu s absolventmi sa skladá z častí správy 
základných nastavení, importu a exportu dát a priameho prístupu do databázy v časti 
používateľov. 

 
Obr. 21.: Základné nastavenia systému ALUMNI 
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Obr. 22.: Vstupné pole na importovanie dát 

Importovanie dát je prispôsobené schéme systému YONBAN a umožňuje import vo 
viacerých formátoch, teda ako formát Excel, SQL skript, alebo Webservice. 
 
 
 

 
Obr. 23.: Exportovanie dát 

Exportný formát, do ktorého je možné dáta systému ALUMNI exportovať je formát Excelu. 
 
Na obrázku 24 je znázornená časť systému, ktorý umožňuje pridať používateľa priamo do 
databázy. Tým sa obíde globálny import dát zo systému YONBAN. V oboch poliach (1) aj 
(2) sa zadávajú základné dáta o vybranom absolventovi. Na tejto stránke je možné zároveň 
priamo zmeniť heslo používateľa systému. 



IINNFFOORRMMAAČČNNÝÝ  SSYYSSTTÉÉMM  PPRREE  KKOOMMUUNNIIKKÁÁCCIIUU  SS  AABBSSOOLLVVEENNTTMMII  
 

  AADD MM II NN II SS TTRR ÁÁ TTOO RR SS KK ÁÁ   PP RR ÍÍ RR UUČČKK AA   KK   SS YY SS TT ÉÉ MM UU   AALLUU MMNNII   SS TTRR AA NN AA   1155     

 
Obr. 24.: Pridanie používateľa do databázy 

 

 
Obr. 25.: Výber používateľov z databázy 

Absolventa, ktorého vyberieme na editáciu v okne na obrázku 24 pomocou odkazu „Vyber“ 
na obrázku 25 (2) môžeme vyhľadávať na karte používatelia (viď obr. 25). V poli (1) sú 
vstupné záznamy na zobrazenie filtrovaných zoznamov absolventov v poli (2). Vyhľadávanie 
je možné podľa zamerania, prihlasovacieho mena a priezviska. 
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44..33..   VVyyttvvoorreenniiee   OODDBBCC  zzddrroojjaa   
Pre korektný beh aplikácie byť vytvorený ODBC dátový zdroj ako System DNS, v prípade že 
je tento zdroj vytvorený ako User DNS aplikácie bude korektne pracovať len v lokálnom 
prostredí. ODBC Data Sources nájdeme v Control Panel v Administrative Tools (viď obr. 26)  

 
Obr. 26.: Správa ODBC Data Sources 

 
Obr. 27.: ODBC Data Source – System DSN 
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Obr. 28.: Vytvorenie Data Source 

Taktiež musí mať tento dátový zdroj presný názov „PostgreSQL_ALUMNI“, inak nebude 
aplikácia schopná nadviazať spojenie s databázou. 
 

 
Obr. 29.: Vyplnenie časti s PostgreSQL Unicode ODBC Driver 

 

 
Obr. 30.: Potvrdenie spojenia k databázovému serveru 
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44..44..   IInnšš ttaa lláácc iiaa   II IISS  zz   CCDD  WWiinnddoowwss   XXPP  aa lleebboo  WWiinnddoowwss   SSeerrvvee rr   
Pre potreby aplikácie je nutné spustenie web servera, ktorý dokáže spracovávať ASPX 
technológiu. Odporúčame Internet Information Server od spoločnosti Microsoft. Postup 
inštalácie je nasledovný: 

1. Tlačidlo Start  
2. Menu položka Settings 
3. Control Panel 

 
Obr. 31.: Spustenie ovládacích panelov 

4. Vybrať Add or Remove Programs 

 
Obr. 32.: Pridanie / odstránenie programov 
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5. Po otvorení okna z nainštalovanými programami je potrebné zvoliť položku 
Add/Remove Windows Components 

 

  
Obr. 33.: Spustenie Add/Remove Windows Components 
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6.  Ďalší krok je vybratie Windows komponentu Internet Information Server (IIS)  

 
Obr. 34.: Povolenie Internet Information Services (IIS) 

 
7. Po stlačení tlačidla next je výzva na vloženie inštalačného CD Windows XP, ostatné 

časť prebehnú automaticky 
 


